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1.  About ICT Circuit Software 

ICT Circuit is a Web Based Online Electrical & Electronic Circuit Simulation and Evaluation Tool.  It is a Virtual Laboratory.   

1.1 ICT Circuit Software was developed based on the broad guidelines provided by the National Mission on Education 

through ICT under the Ministry of Human Resource Development. 
 

1.2 ICT Circuit Software is developed keeping in mind the following objectives: 

o To provide remote-access to Electrical and Electronic Circuit Laboratories.  This ICT Circuit Software would 

cater to learners at the undergraduate level, post graduate level as well as to research scholars. 

o To enthuse learners to conduct online experiments by arousing their curiosity. This would help them in 

learning basic and advanced concepts through remote experimentation. 

o To integrate features of Learning Management System in the ICT Circuit Software (Virtual Labs) where the 

faculty members can allocate practice exercises to learners; and learners can use the various electronic active 

and passive components to build demonstrations and evaluate their designs. 

o To save costly equipment and resources, which are otherwise available in a limited number for users due to 

the constraints on time and geographical distances. 
 

1.3 ICT Circuit Software has the following advantages: 

o Prepare Learners to use real laboratories without the risk of damaging equipment or injuring themselves 

o Learners can try all kinds if experiments without any hesitation and to correct their misconceptions 

o Learners can compare their assumptions with reality 

o The tool encourages exploring and manipulating their circuits for variables in an independent way 

o Learners can conduct experiments that are almost impossible even in the most generously funded laboratories 

o Learners perform a series of experiments that yield authentic results 

o Learners can practice simulation laboratory experiments in a safe online environment 

o Learners can simulate circuits from their own ideas to the circuits which are taken from various core concepts 

in engineering field which are essential for current industrial requirements 

o Faculty members can assign and interact with the learners and can help them to achieve the end results 

through this platform 

o Faculty members can provide lab assignments that instruct learners how to use the laboratory, step-by-step 

o Rich and interactive user interface 
 

1.4 ICT Circuit Software also integrates the best learning practices followed in MKCE : 

o Critical Thinking o Analytical Reasoning o Reflective Thinking 

o Problem Solving o Scientific Reasoning o Design thinking  
 

1.5 ICT Circuit Software supports the following Learning Paradigms: 

o Inquiry Based Learning o Virtual Learning o Progressive Inquiry Learning 

o Problem Based Learning o Project Based Learning o Self-Learning 

o Flipped Class Learning o Life Long Learning o Online Learning 
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2.  Creating a Course 

The ICT Circuit Software start up page is given below:  

 
 

The ICT Circuit portal is where the learner gain access to their account which allows them to practice circuits from various 
different concepts. There are few modules available in ICT Circuit portal which are mentioned below: 

• Course Coordinator 
• Faculty Member 
• Learner (Student) 

2.1  Creating an Account: 

Each Faculty and learner should create an account on ICT Circuit portal in order to use the tool, users can click on the 
round “+” button, and you will be prompted to select faculty or student, select your role, 

 
You will be directed to a Registration form page as show below, 

If you are a faculty, 
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If you are a learner, 

 
Once you have filled every field with valid information click “REGISTER” button. If the information you have entered is 
correct you will receive a message as “SUCCESSFULLY REGISTERED” 

2.2  Course Coordinator 

 
 

In ICT Circuit Software there are various courses available, for each course there is a coordinator account which allows the 
user to add faculties to their respective courses only then learners can select the faculty for their respective course selection. 
If a faculty member wants to be a coordinator, the login credentials will be provided by the ICT Circuit Administrator. The 
Roles of the course coordinator is given below: 

• Add/edit session: There are totally 10 sessions for every course. Editing the session must be done before learners 
starts using the ICT Circuit Portal. 

• Add question: Coordinator can add question either by typing individually or by using the question upload csv 
template which can be downloaded from the IMPORT QUESTIONS box. 
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• View /edit question: Coordinator has the permission to add or edit question and also upload the “jpg” format of 
the solution key for the question. 

• Add faculty: Coordinator has to add the faculty to their respective course only then learners can find the name of 
the faculty during course selection. 

• Generate faculty wise report for that course 

 
 

2.3  Course Faculty 

Once the faculty account is created by the above mentioned steps, faculty can login into their respective account. A faculty 
must request the course coordinator to register their name under the respective course. The Roles of the Faculty are: 

• Accept learner course request: Faculty can accept the learner request for the respective course once by cross-
checking the learner registration number. 

 
 

• Evaluation of submitted circuit: Once the learner has designed and submitted their circuit, faculty can view the 
learner submissions in “Circuit Submissions” and can accept or reject the learner submissions 
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• Generate learner wise report: Faculty can generate learner reports in Report option.Faculty has to select the course 
and click submit to view the learner details and to generate learner report in CSV format click, View->CSV 

 
• Responding to reports: Faculty can respond to learner query regarding the circuit using Repot Queries option and 

if they find any valid report from the learner faculty can forward it to the course coordinator for any changes in the 
question. 

2.4  Learner 

 
 

Once the student learner account is created by above mentioned step, Learners can login into their account at first there will 
be no courses available on learners account. Learner have to register for a course under the respective course faculty. The 
Role of the Student Learner are: 

• Send course request to respective faculty 

 



 

M.Kumarasamy College of Engineering  |  ICT Circuit – User Manual   |  [Version 1.7]  [Released 01 July 2019]                                                                   [8] 
 

Once the faculty has accepted the learner’s course request the learner can click “CONTINUE PRACTICE” button to view 
their question circle. 

 
 

 
 

The question circle contains 100 segments under 10 sessions, each segment with unique questions related to the session 
which will allow the learner to design the solution circuit for the given question in the given workspace. 

• Designing circuit for the given question description: Learner can click on the question circle segment to view and 
design the circuit, the question page contains the following: Problem Description, Question ID, Question image, 
ICT Circuit’s workspace 
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• Saving the circuit: After designing the circuit the learner have click File-> Save Circuit to save the circuit. If the 
circuit is designed properly without any errors the display box with “Saved successfully” appears. 

• Submit the circuit: Now to submit the circuit, “CIRCUIT SUBMISSION” button has to be clicked, Once the circuit 
is submitted properly the display box turns to yellow in color. 

 
 

Learner can also design different circuits for the given test cases in the same work space and label them with text boxes. 

• Report any question in case of any query: Learner can raise a valid query by clicking on the “Report issues” option 

Color Scheme: Color scheme in the Student learner page indicates the status of the question status, it can be seen in question 
circle segments and the question page, 

o RED: The red color question circle segment indicates the question is NOT ATTEMPTED The red color in the 
question page indicates the question has been rejected by the faculty and learner must resubmit with proper design. 

o YELLOW: The yellow color in question circle segment and question page indicates the question is either viewed or 
submitted 

o GREEN: The green color in question circle segment and question page indicates the question is submitted and 
approved by the faculty 
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3.  Browser Requirements 

This ICT Circuit Portal makes extensive use of HTML5 features and definitely needs a modern browser. It also performs a 
lot of calculations in JavaScript and the speed of this varies a lot between browsers. Currently Chrome seems to have the 
best performance and feature support for this application. Internet Explorer also runs the JavaScript well but sadly lacks 
compatibility with all the file menu options.  

The capability to load and save files to the local disk requires HTML5 features that are not supported in all browsers. If the 
application detects the features required are not supported then some of the file options will be unavailable. Currently 
Chrome support all the needed features. 

4.  Circuit Elements 

The circuit elements available for constructing a circuit are:  

Passive Components Inputs and Sources Outputs and Labels Active Components 
Resistor Ground Analog input Diode 
Capacitor Voltage Sources (2-terminal) LED Zener Diode 
Capacitor (polarized) A/C Voltage Source (2-terminal) Lamp Transistor (bipolar, NPN) 
Inductor Voltage Source (1-terminal) Text Transistor (bipolar, PNP) 
Switch A/C Voltage Source (1-terminal) Box MOSFET (N-Channel) 
Push Switch Square Wave Source (1-terminal) Voltmeter / Scope Probe MOSFET (P-Channel) 
SPDT Switch Clock Labeled Node JFET (N-Channel) 
Potentiometer A/C Sweep Test Point JFET (P-Channel) 
Transformer Variable Voltage Ammeter SCR 
Tapped Transformer Antenna Data Export Darlington Pair (NPN) 
Transmission Line AM Source Audio Output Darlington Pair (PNP) 
Relay FM Source  Tunnel Diode 
Memristor Current Source  Triode 
Spark Gap Noise Generator   

 

Active Building Blocks Logic Gates,  
Input&Output 

Digital Chips Analog and Hybrid Chips 

Op Amp (- on top) Logic Input D Flip-Flop 555 Timer 
Op Amp (+ on top) Logic Output JK Flip-Flop Phase Comparator 
Analog Switch (SPST) Inverter T Flip-Flop DAC 
Analog Switch (SPDT) NAND Gate 7 Segment LED ADC 
Tristate Buffer NOR Gate 7 Segment Decoder VCO 
Schmitt Trigger AND Gate Multiplexer Monostable 
Schmitt Trigger (Inverting) OR Gate Demultiplexer  
CCII+ XOR Gate SIPO Shift Register  
CCII-  PISO Shift Register  
Comparator (Hi-Z/GND o/p)  Counter  
OTA (LM13700 style)  Decade Counter  
Voltage-Controlled Voltage Source  Latch  
Voltage-Controlled Current Source  Sequence Generator  
Current-Controlled Voltage Source  Full Adder  
Current-Controlled Current Source  Half Adder  
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5. Constructing and Editing Circuits 

To add component to form a circuit, click the right mouse button on an unused area of the window.  This will bring up a 
menu that allows you to select what component you want.  Then click where you want the first terminal of the component, 
and drag to where you want the other terminal.  The menu items allow you to create: 

 

• Wires :you can also display current through wire by right click->edit->view current 
• Resistors: you can adjust the resistance after creating the resistor by clicking the right mouse button and selecting 

“Edit” 

      

• Capacitors: you can adjust the capacitance using “Edit” 
• Inductors, switches, transistors, etc. 
• Voltage sources, in either 1-terminal or 2-terminal varieties.  The 1-terminal versions use ground as the other 

terminal.  By clicking the right mouse button and selecting “Edit”, you can modify the voltage and the waveform 
of the voltage source, changing it to DC, AC (sine wave), square wave, triangle, saw tooth, or pulse.  If it’s not a 
DC source, you can also change the frequency and the DC offset. 

• op-amps, with power supply limits of –15V and 15V assumed (not shown).  The limits can be adjusted using 
“Edit”. 

• Text labels, which you can modify with the “Edit” dialog 
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• Test points: these have no effect on the circuit, but if you select them and use the right mouse menu item “View 
in Scope”, you can view the voltage difference between the terminals. 

Also in the “Other” submenu, there are some items that allow you to click and drag sections of the circuit around. 

You can drag the circuit around by clicking and dragging with the Alt key held down.  Zoom in and out with the mouse 
wheel or by using the zoom commands in the Edit menu. 

To edit one of the scope views, click the right mouse button on it to view a menu.  The menu items allow you to remove a 
scope view, speed up or slow down the display, adjust the scale, select what value(s) you want to view, etc. 

The time step size is the time between iterations of the Sample circuit.  Smaller time steps make the simulation more accurate, 
but slower.  A smaller time step size is required to simulate high frequencies.  A larger time step size may be appropriate for 
circuits that run in real time.  Use Edit->Other Options… to change the time step size. 

File->Recover Auto-Save lets you recover a circuit lost when the Sample circuit window was closed.  If this doesn’t work, 
try Edit->Undo instead. 

File->Find DC Operating Point is useful with circuits that take a long time to reach a useful state.  This option instantly 
charges all the capacitors. 

Here are some errors you might encounter when using the Sample circuit: 

• Voltage source loop with no resistance! – This means one of the voltage sources in your circuit is shorted.  Make 
sure there is some resistance across every voltage source. 

• Capacitor loop with no resistance! – It’s not allowed to have any current loops containing capacitors but no 
resistance.  For example, capacitors connected in parallel are not allowed; you must put a resistor in series with 
them.  Shorted capacitors are allowed. 

• Singular matrix! – This means that your circuit is inconsistent (two different voltage sources connected to each 
other), or that the voltage at some point is undefined.  It might mean that some component’s terminals are 
unconnected; for example, if you create an op-amp but haven’t connected anything to it yet, you will get this error.   

• Convergence failed! – This means the Sample circuit can’t figure out what the state of the circuit should be.  Just 
click Reset and hopefully that should fix it.  Your circuit might be too complicated, but this happens sometimes 
even with the examples. 

• Transmission line delay too large! – The transmission line delay is too large compared to the time step of the 
Sample circuit, so too much memory would be required.  Make the delay smaller. 

• Need to ground transmission line! – The bottom two wires of a transmission line must always be grounded in 
this Sample circuit. 

Sensors, Transducers and Interactions with the External World 

Electronic circuits don't exist in isolation - most circuits have a purpose that involves interaction with the external world. 
In the simulation we've added some common types of input and output (e.g. switches and LEDs) but there are many 
types of transducers and we don't model all of them. We are also not simulating all the physical effects that occur outside 
the electronic domain - e.g. how the load torque might vary as a motor moves a mechanism leading to changes to the 
motor's electrical characteristics. 

If you find you want to simulate a circuit with a type of transducer that isn't in the model, e.g. a thermistor, you can just 
use an electrically equivalent component. So, for a thermistor just use a resistor and set it to different values to represent 
different temperatures. The sliders feature may be particularly useful for this purpose. 
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Annexure – I  

 
Pre-built Sample Circuits 

 
Pre-built Sample Circuits in ICT Circuits Software are provided to: 

o Help faculty members save the time taken in drawing / constructing the circuit while teaching 
o Help Learners to understand and reinforce learning by running simulations with different values 
o Suitably alter/modify/update a circuit to understand functionalities better.  

Pre-built sample circuits are provided in the menu “Circuits”. A Sample RLC circuit is shown below: 

 

The "Circuits" menu contains pre-built circuits to view, modify, learn, experiment and practice.  
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Some of the Pre-built Sample Circuits Provided are:  

1.  Basic Circuits: 

o Resistors: Learn about resistors of various sizes in series and parallel formation 
o Capacitor: Learn about capacitor functions, that one can charge and discharge. 
o Inductor: Learn about inductor functions, that one can charge and discharge. 
o RLC Circuit: Learn about an oscillating RLC circuit with an inductor, resistor, and capacitor.  One can close the switch 

to get current moving in the inductor, and then open the switch to see the oscillation. 
o Voltage Divider: Learn about voltage divider, that generates a reference voltage of 7.5V, 5V, and 2.5V from the 10V 

power supply. 
o Thevenin’s Theorem: Learn about thevenin’s equivalent; that the two circuits provided are equivalent. 
o Norton’s Theorem: Learn about norton’s equivalen; that the two circuits provided are equivalent. 

2.  A/C Circuits 

o Capacitor: Learn about a capacitor connected to an alternating voltage source. 
o Inductor:  Learn about an inductor that can be charged and discharged by clicking on the switch. 
o Capacitors of Various Capacitances: Learn the response of three different capacitors to the same frequency. 
o Capacitors w/o Various Frequencies: Learn the response of three equal capacitors to three different frequencies; the 

higher the frequency, the larger the current. 
o Inductors of Various Inductances: Learn the response of three different inductors to the same frequency. 
o Inductors w/o Various Frequencies: Learn the response of three equal inductors to three different frequencies: the 

lower the frequency, the larger the current. 
o Impedances of Same Magnitude: Learn that a capacitor, an inductor, and a resistor that have impedances of equal 

magnitude (but different phase).  The peak current is the same in all three cases. 
o Series Resonance: Learn that three identical RLC circuits being driven by three different frequencies; (i) being driven 

at a slightly lower frequency (ii) being driven at the resonance frequency and (iii) being driven by a slightly higher 
frequency.  The peak voltage in the circuit-(ii) is very high because it is resonating with the source. 

o Parallel Resonance: Learn that three circuits have the inductor, resistor, and capacitor in parallel instead of series.  In 
this case, the middle circuit is being driven at resonance, which causes the current there to be lower than in the other 
two cases (because the impedance of the circuit is highest at resonance). 

3.  Passive Filters 

o High-Pass Filter (RC):  The original signal is shown at the lower left, and the filtered signal (with the low-frequency 
part removed) is shown to the right.  The breakpoint (-3 dB point) is shown at the lower right, as “f.3db”. 

o Low-Pass Filter (RC) 
o High-Pass Filter (RL):  This high-pass filter uses an inductor rather than a capacitor. 
o Low-Pass Filter (RL) 
o Band-Pass Filter: This filter passes a range of frequencies close to the resonance frequency  
o Notch Filter: Also known as a band-stop filter, this circuit filters out a range of frequencies close to the resonance 

frequency. 
o Twin-T Filter: This filter does a very good job of filtering out 60 Hz signals. 
o Crossover:  A set of three filters; the top one passes low frequencies, the middle one passes midrange, and the bottom 

one passes high frequencies. 

4.  Other Passive Circuits 

o Series/Parallel 
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• Inductors in Series 
• Inductors in Parallel 
• Capacitors in Series 
• Capacitors in Parallel 

o Transformers 
• Transformer: A basic transformer circuit with an equal number of windings in each coil. 
• Transformer w/ DC: Here we try to pass a DC current through a transformer. 
• Step-Up Transformer: Here we step 10 V up to 100 V. 
• Step-Down Transformer: Here we step 120 V down to 12 V. 

o 3-Way Light Switches: shows how a light bulb can be turned on and off from two locations. 
o 3- and 4-Way Light Switches: shows how a light bulb can be turned on and off from three locations. 
o Differentiator: shows how a capacitor can act as a differentiator, reflecting changes in voltage. 
o Wheatstone Bridge: shows a balanced Wheatstone bridge.  If the bridge were not balanced, current would be flowing 

across from one leg to the other. 
o Critically Damped LRC. 
o Current Source: shows a source that keeps the current through the circuit constant regardless of the switch positions. 
o Inductive Kickback: In this circuit, we have a switch that controls the supply of current to an inductor.  An inductor 

resists any changes in current.  If you open the switch, the inductor tries to maintain the same current; it does this by 
charging the capacitance between the contacts of the switch.  (Any two wires in close proximity have some parasitic 
capacitance between them.)  There is a small capacitor (much larger than the actual value) across the switch terminals 
to simulate this.  When you open the switch, the voltage goes very high; in real life, this would cause arcing. 

o Blocking Inductive Kickback: shows how inductive kickback can be blocked with a“snubber”circuit. 
o Power Factor: This circuit shows an inductor being driven by an AC voltage.  The colors indicate power consumption; 

red means that a component is consuming power, and green means that the component is contributing power.  The 
left side of the circuit represents the power company’s side, and the right side represents a factory. 
The highly inductive load is causing the power company to work a lot harder than normal for a given amount of 
power delivered.  The graph on the left indicates the power lost in the power company’s equipment (the resistor at 
top left).  The graph in the middle is the power delivered to the factory.  Even though a peak power of 40 mW is 
being delivered to the factory, 200 mW is being dissipated in the power company’s wires.  This is why power 
companies charge extra for inductive loads. 

o Power Factor Correction: Here a capacitor has been added to the circuit, causing far less energy to be wasted in the 
power company’s wires (aside from an initial spike to charge the capacitor). 

o Resistor Grid: shows current flowing in a two-dimensional grid of resistors. 
o Coupled LC's 
o   LC Modes(2): Shows both modes of two coupled LC circuits. 
o   Weak Coupling.  
o   LC Modes(3): Shows all 3 modes of 3 coupled LC circuits. 
o   LC Ladder: This circuit is a simple model of a transmission line.  A pulse propagates down the length of the ladder 

like a wave.  The resistor at the end has a value equal to the characteristic impedance of the ladder (determined by the 
ratio of L to C), which causes the wave to be absorbed.  A larger resistance or an open circuit will cause the wave to 
be reflected; a smaller resistance or a short will cause the wave to be reflected negatively.   

o Phase-Sequence Network: This circuit generates a series of sine waves with a phase difference of 90°. 

5.  Diodes 

o Half-Wave Rectifier: This circuit removes the negative part of an input waveform. 
o Full-Wave Rectifier: This circuit replaces a waveform with its absolute value. 
o Full-Wave Rectifier w/ Filter: This circuit smoothes out the rectified waveform, doing a pretty good job of converting 

AC to DC. 
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o Diode I/V Curve: This demonstrates the response of a diode to an applied voltage.  The voltage source generates a 
sawtooth wave, which starts out at –800 mV and slowly rises to 800 mV, and then immediately drops back down 
again. 

o Diode Limiter. 
o DC Restoration.  This takes an AC signal and adds a DC offset, making it a positive signal. 
o Blocking Inductive Kickback: shows how inductive kickback can be blocked with a diode. 
o Spike Generator. 
o Voltage Multipliers 

• Voltage Doubler: Doubles the voltage in the AC input signal (minus two diode drops), and turns it into DC. 
• Voltage Doubler 2 
• Voltage Tripler 
• Voltage Quadrupler 

o AM Detector: This is a “crystal radio”, an AM radio receiver with no amplifier.  The raw antenna feed is shown in 
the first scope slot in the lower left.  The inductor and the capacitor C1 are tuned to 3 kHz, the frequency shown in 
the lower right as “res.f”.  This picks up the carrier wave shown in the middle scope slot.  A diode is used to rectify 
this, and the C2 capacitor smoothes it out to generate the audio signal in the last scope slot (which is simply a 12 Hz 
sine wave in this example).  By experimenting with the value of C1’s capacitance, you can pick up two other “stations” 
at 2.71 kHz and 2.43 kHz. 

o Triangle-to-Sine Converter 

6.  Op-Amps 

o Amplifiers 
• Inverting Amplifier: This one has a gain of –3. 
• Non-Inverting Amplifier 
• Follower 
• Differential Amplifier 
• Summing Amplifier 
• Log Amplifier: output is the (inverted) log of the input 
• Class D Amplifier 

o Oscillators 
• Relaxation Oscillator 
• Phase-Shift Oscillator 
• Triangle Wave Generator 
• Sine Wave Generator 
• Saw tooth Wave Generator 
• Voltage-Controlled Oscillator: Here the frequency of oscillation depends on the input (shown in the scope on 

the left).  The oscillator outputs a square wave and a triangle wave. 
• Rossler Circuit 

o Half-Wave Rectifier: An active rectifier that works on voltages smaller than a diode drop. 
o Full-Wave Rectifier 
o Peak Detector: This circuit outputs the peak voltage of the input.  Whenever the input voltage is higher than the 

output, the output will be adjusted upward to match.  Press the switch marked “reset” to reset the peak voltage back 
to 0. 

o Integrator 
o Differentiator 
o Schmitt Trigger 
o Negative Impedance Converter: Converts the resistor to a “negative” resistor.  In the first graph, note that the current 

is 180° out of phase with the voltage. 
o Gyrator: The top circuit simulates the bottom circuit without using an inductor. 
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o Capacitance Multiplier: This circuit allows you to simulate a large capacitor with a smaller one.  The effective 
capacitance of the top circuit is C1 x (R1/R2), and the effective resistance is R2. 

o Howland Current Source 
o I-to-V Converter: The output voltage depends on the input current, which you can adjust with the switches. 

741 Internals: The implementation of a 741 op-amp. 

7.  Transistors 

o Switch. 
o Emitter Follower. 
o Astable Multivibrator: A simple oscillator.   
o Bistable Multivibrator (Flip Flop): This circuit has two states; use the set/reset switches to toggle between them. 
o Monostable Multivibrator (One-Shot): When you hit the switch, the output will go to 1.7 V for a short time, and then 

drop back down. 
o Common-Emitter Amplifier: This circuit amplifies the voltage of the input signal by about 10 times. 
o Unity-Gain Phase Splitter: Outputs two signals 180° out of phase from each other. 
o Schmitt Trigger. 
o Current Source: The current is the same regardless of the switch position. 
o Current Source Ramp: Uses a current source to generate a ramp waveform every time you hit the switch. 
o Current Mirror: The current on the right is the same as the current on the left, regardless of the position of the right 

switch. 
o Differential Amplifiers 

• Differential Input: This circuit subtracts the first signal from the second and amplifies it. 
• Common-Mode Input: This shows a differential amplifier with two equal inputs.  The output should be a 

constant value, but instead the input waveforms make it through to the output (attenuated rather than 
amplified).  (When both inputs change together, that is called “common-mode input”; the “common-mode 
rejection ratio” is the ability of a differential amplifier to ignore common-mode signals and amplify only the 
difference between the inputs.) 

• Common-Mode w/Current Source: This is an improved differential amplifier that uses a current source as a 
load.  The common-mode rejection ratio is very good; the circuit amplifies the small differences between the 
two inputs, and ignores the common-mode signal. 

o Push-Pull Follower: This is another type of emitter follower. 
o Oscillators 

• Colpitts Oscillator 
• Hartley Oscillator 
• Emitter-Coupled LC Oscillator 

o JFETs 
• JFET Current Source 
• JFET Follower: This is like an emitter follower, except that the output is 3V more positive than the input. 
• JFET Follower w/zero offset 
• Common-Source Amplifier 
• Volume Control: Here the JFET is used like a variable resistor. 

8.  MOSFETs 

o CMOS Inverter: The white “H” is a logic input.  Click on it to toggle its state.  “H” means “high” (5 V) and “L” 
means “low” (0 V).  The output of the inverter is shown at right, and is the opposite of the input.  In this (idealized) 
simulation, the CMOS inverter draws no current at all. 

o CMOS Inverter (w/capacitance): In reality, there are two reasons that CMOS gates draw current.  This circuit 
demonstrates the first reason: capacitance between the MOSFET gate and its source and drain.  It requires current to 
charge this capacitance, which consumes power.  It also causes a short delay when changing state. 
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o CMOS Inverter (slow transition): The other reason that CMOS gates draw current is that both transistors will conduct 
at the same time when the input is halfway between high and low.  This causes a current spike when the input is in 
transition.  In this circuit, there is a low-pass filter on the input which causes it to transition slowly, so you can see the 
spike. 

o CMOS Transmission Gate: This circuit will pass any signal, even an analog signal (as long as it stays between 0 and 5 
V) when the gate input is “H”.  When it’s “L”, then the gate acts as an open circuit. 

o CMOS Multiplexer: This circuit uses two transmission gates to select one of two inputs.  If the logic input is “H”, 
then the output is a 40Hz triangle wave.  If it’s “L”, then the output is a 80Hz sine wave. 

o Sample-and-Hold: Click and hold the “sample” button to sample the input.  When you release the button, the output 
level will be held constant. 

o Delayed Buffer: This circuit delays any changes in its input for 15 microseconds. 
o Leading-Edge Detector 
o Switchable Filter: Click the “L” to select from two different low-pass filters. 
o Voltage Inverter 
o Inverter Amplifier: This shows how a CMOS inverter can be used as an amplifier. 
o Inverter Oscillator 

9.   555 Timer Chip 

o Square Wave Generator 
o Internals: The implementation of a 555 chip, acting as a square wave oscillator 
o Saw tooth Oscillator 
o Low-duty-cycle Oscillator: produces short pulses. 
o Monostable Multivibrator: This is a one-shot circuit that will produce a timed pulse when you click the “H”. 
o Pulse Position Modulator: Produces pulses whose width is proportional to the input voltage. 
o Schmitt Trigger 
o Missing Pulse Detector: Setting the logic input low will turn off the square wave input.  The missing pulse detector 

will detect the missing input and bring the output high. 

10.  Active Filters 

o VCVS Low-Pass Filter: An active Butterworth low-pass filter. 
o VCVS High-Pass Filter 
o Switched-Capacitor Filter: A digital filter, implemented using capacitors and analog switches. 

11.  Logic Families 

o RTL Logic Family 
• RTL Inverter: The white “H” is a logic input.  Click on it to toggle its state.  “H” means “high” (3.6 V) and 

“L” means “low” (0 V).  The output of the inverter is shown at right, and is the opposite of the input. 
• RTL NOR: The three inputs are at the bottom, and the output is to the right.  The output is “L” if any of the 

inputs are “H”.  Otherwise it’s “H”. 
• RTL NAND: The output is “H” unless all three inputs are “H”, and then it’s “L”. 

o DTL Logic Family 
• DTL Inverter 
• DTL NAND 
• DTL NOR 

o TTL Logic Family 
• TTL Inverter 
• TTL NAND 
• TTL NOR 
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o NMOS Logic Family 
• NMOS Inverter 
• NMOS Inverter 2: This uses a second MOSFET instead of a resistor, to save space on a chip. 
• NMOS NAND 

o CMOS Logic Family 
• CMOS Inverter 
• CMOS NAND 
• CMOS NOR 
• CMOS XOR 
• CMOS Flip-Flop (or latch): This circuit consists of two CMOS NAND gates. 
• CMOS Master-Slave Flip-Flop 

o ECL Logic Family 
• ECL NOR/OR 

o Ternary: This demonstrates three-valued logic, where the inputs can be 0, 1, or 2 instead of H and L.  This logic is 
implemented using MOSFETs; the threshold voltage of each one is shown. 
• CGAND: the output is 2-X where X is the minimum of the two inputs. 
• CGOR: the output is 2-X where X is the maximum of the two inputs. 
• Complement. 
• F211: 0 becomes 2, 1 becomes 1, 2 becomes 1. 
• F220 
• F221 

12.  Combinational Logic 

o Exclusive OR (XOR)  
o Half Adder 
o Full Adder 
o 1-of-4 Decoder 
o 2-to-1 Mux: This multiplexer uses two tri-state buffers connected to the output. 
o Majority Logic: The output is high if a majority of the inputs are high. 
o 2-Bit Comparator: Tells you if the two-bit input A is greater than, less than, or equal to the two-bit input B. 
o 7-Segment LED Decoder 

13.  Sequential Logic 

o Flip-Flops 
• SR Flip-Flop 
• Clocked SR Flip-Flop 
• Master-Slave Flip-Flop 
• Edge-Triggered D Flip-Flop: This circuit changes state when the clock makes a positive transition. 

o Counters 
• 4-Bit Ripple Counter 
• 8-Bit Ripple Counter 
• Synchronous Counter 
• Decimal Counter 
• Gray Code Counter 
• Johnson Counter 

o Divide-by-2: Divides the input frequency by 2. 
o Divide-by-3 
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o LED Flasher: This circuit uses a decade counter to flash some LED’s in a back and forth pattern. 
o Traffic Light 
o Dynamic RAM: This is a simple model of a dynamic RAM chip.  To read from the chip, select the bit you want using 

the row select lines.  To write, select the data bit you want to write, and click the “write” switch.  To refresh a bit, 
click the “refresh” switch. 

 

14.  Analog/Digital 

o Flash ADC: This is a direct-conversion, or “flash” analog-to-digital converter. 
o Delta-Sigma ADC 
o Half-Flash (Sub ranging) ADC: Also known as a pipeline ADC.  The first stage converts the input voltage to a four-

bit digital value.  Then, a DAC converts these four bits to analog, and then a comparator calculates the difference 
between this and the input voltage.  Another ADC converts this to digital, giving a total of eight bits.  

o Binary-Weighted DAC:  Converts a four-bit binary number to a negative voltage. 
o R-2R Ladder DAC 
o Switch Tree DAC 
o Digital Sine Wave 

15.  Phase-Locked Loops 

o XOR Phase Detector: Shows an XOR gate being used as a type I phase detector.  The output is high whenever the 
two input signals are not in phase. 

o Type I PLL: This phase-locked loop circuit consists of an XOR gate (the phase detector), a low-pass filter (the resistor 
and capacitor), a follower (the op-amp), and a voltage-controlled oscillator chip.  The voltage-controlled oscillator 
outputs a frequency proportional to the input voltage.  After the PLL circuit locks onto the input frequency, the 
output frequency will be the same as the input frequency (with a small phase delay). 

o Phase Comparator (Type II): Shows a more sophisticated phase detector, which has no output when the inputs are 
in phase, but outputs high (5V) when input 1 is leading input 2, and low (0V) when input 2 is leading input 1.  The 
phase comparator and VCO in this applet are based on the 4046 chip. 

o Phase Comparator Internals. 
o Type II PLL: Shows a phase-locked loop with a type II phase detector.  If you adjust the input frequency, the output 

should lock onto it in a short time. 
o Type II PLL (fast): Just a faster simulation of the type II PLL. 
o Frequency Doubler 

16.  Transmission Lines 

o Simple TL: A properly terminated transmission line, showing the delay as the signal travels down the line. 
o Standing Wave: A standing wave on a shorted transmission line. 
o Termination: The top line is terminated properly, but the others are not, and so the incoming wave is reflected. 
o Mismatched lines: Shows reflections caused by the middle line having a different impedance than the other two lines. 
o Mismatched lines 2: Shows a standing wave on the first line, caused by the second line having a different impedance. 
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